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INTRODUCTION 

   
Hello and thanks for downloading my ebook! 
 
First off a little bit about myself… originally from Leicestershire, UK I moved to Ireland back in 2007 
with my other half and a suitcase!  
 
After a few years in Ireland, not to mention the 18 years in the UK, of working in a variety of 
administrative roles for other people, I decided to take the plunge and start my own business in 
2010. 
And that’s when OutofhoursAdmin was born; a virtual assistant service providing remote admin 
support to businesses throughout Ireland and the UK. 
 
After receiving numerous questions about MS Office from clients, I decided to share my answers in 
the form of tutorials which I post regularly on my blog.  
 
This ebook is a compilation of all my tutorials from my blog for Microsoft Excel 2007 put together in 
a handy guide which I hope you will find useful. 
 
And, don’t forget if you want an extra pair of hands to help with any of your administration, get in 
touch by emailing me at sharon@outofhoursadmin.ie or you can connect with me on Facebook, 
LinkedIn or subscribe to my YouTube channel. 
 
Thanks, 
 

Sharon 
 
 
 
 
 
 
 
  

http://www.outofhoursadmin.ie/
http://www.outofhoursadmin.ie/category/blog/
mailto:sharon@outofhoursadmin.ie
https://www.facebook.com/OutofhoursAdmin/
http://ie.linkedin.com/in/outofhoursadmin
http://www.youtube.com/user/outofhoursadmin/videos
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HOW TO START (& MAINTAIN) A PRODUCTIVE DAY 
 
I’m not a morning person!  I admit that I struggle for the first couple of hours of the day but being a 
Virtual Assistant means I’m lucky enough to work from home and schedule work in to fit around my 
peak times.  We’re all different and our productivity levels peak at different times during the day (& 
night) yet the majority of us end up working against our body clock, struggling to be productive at 
the wrong time. 
 
If your working day isn’t flexible enough and you have to work during “off peak” times, how can you 
maintain the same level of productivity that you have during your peak time?  Listed below are a few 
tips to get you started:- 
 

 SLEEP First things first, make sure you get adequate sleep, again everyone is different – 
some people can manage on only 5 hours, others prefer 7-8.  I know if I have less than 7 
then I’m like a tetchy two year old.  However many hours you know you need to wake up 
feeling refreshed, make sure you get that amount! 

 

 DRINK Wipe the smile off your face I’m not talking about alcoholic drink!  I’m talking about 
water!  Drink plenty of water throughout the day & keep yourself hydrated. 

 

 EAT Try to eat little and often to keep your energy levels up – it’s no good not having 
breakfast then having a huge lunch to make up for it.  How many times have you gone out 
for lunch, eaten more than usual then just want to curl up & sleep?  Little and often is the 
key! 

 

 BREAK Taking regular breaks will help you to re-focus.  Try taking a 10 minute break every 
hour – it may sound like you’ll get nothing done as all you’re doing is having breaks, but 
you’ll be surprised at how productive you’ll be. 

 

 EXERCISE I admit this is one area that I struggle with – I’m nice and warm in my office and 
the thought of going for a walk or doing any form of exercise fills me with discontent!  
However, going for a brisk walk during the day will refresh you and you’ll be more focused 
when you return.  I’ve now started going for a 20 minute walk in the morning before I start 
my work and it’s amazing how much more energised I feel afterwards (especially as I’m not a 
morning person!) 
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MS OFFICE 
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WHICH VERSION OF MICROSOFT OFFICE DO I HAVE? 
 
I’m often asked how to do things in Excel or Word by clients, which is fine (that’s what I’m here for). 
My first question is always “what version of Office do you use?” to which the response is usually “I 
have no idea, where does it tell me that?”.  So this short guide is to show you how to find it… 
 
The following screen shots are all from using Excel, however the same would also apply if you were 
in Word or PowerPoint. 
 
Click on the Microsoft Office button in the top left corner of the screen, then click Options, go to 
Resources… 
 

 
 
Alternatively, you can click the start button on your desktop & type Microsoft into the search bar, 
which should then list all Microsoft programs along with the version that you’re using. 
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HOW TO SET YOUR DEFAULT LANGUAGE 
 
I used to find it quite frustrating that my spellchecker would underline words which I knew were 
spelt correctly, it’s because my language settings were automatically defaulted to US English, so I 
changed it. 
 
You can of course change the settings in each application of MS Office individually; this tutorial will 
show you how to do the whole lot in one go. 
 
Click on the Start button, select All Programs… 
 

 
 

Then choose Microsoft Office, Microsoft Office Tools, and click on Microsoft Office 2007 Language 
Settings… 
 

 
 

On the right side will be a list of enabled editing languages, the language you want needs to be in 
this list, if it isn’t you can add it from the languages available list on the left hand side.  This is where 
you can set your default language – in my case I want it to be English (UK). Select your language as 
the primary editing language and click OK… 
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You should then see this message which is basically warning you that you are changing the primary 
language… 
 

 
 

…and that’s it! All of your Microsoft Office programs will now be defaulted to your primary language. 
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HOW TO CUSTOMISE YOUR RECENT FILES LIST 
 
It’s always handy to have your most recent documents displayed at the top of the list when you click 
into Recent Documents, however you can customise this list so it contains as many documents as 
you wish.  
 
Click on the Microsoft Office Button, select Excel Options, click on Advanced from the menu on the 
left, scroll down to the Display section, change the number of the Recent Documents and click OK… 
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EXCEL TUTORIALS 
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QUICK KEYBOARD TIPS 
 
Below is a list of keyboard shortcuts for Excel, most of which I would use on a regular basis. The 
majority of them you probably already know of however there are a couple of shortcuts used for 
formatting which may be useful to know. 
 
Ctrl + PgUp Activates the previous sheet in the workbook 
 
Ctrl + PgDn  Activates the next sheet in the workbook 
 
Ctrl + A   Selects the whole worksheet 
 
Ctrl + B   Makes the selected cells bold 
 
Ctrl + C   Copies the selected cells 
 
Ctrl + D  Fill down 
 
Ctrl + F   Displays the Find dialog box 
 

 
 
Ctrl + G  Displays the Go To dialog box 
 

 
 
Ctrl + H  Displays the Replace dialog box 
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Ctrl + I   Makes the selected cells italic 
 
Ctrl + K   Displays the insert a Hyperlink dialog box 
 

 
 
Ctrl + N  Creates a new default workbook 
 
Ctrl + O  Displays the Open dialog box 
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Ctrl + P   Displays the Print dialog box 
 

 
 
Ctrl + R   Fills to the right 
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Ctrl + S   Saves the active workbook 
 
Ctrl + T   Creates a new Table 
 

 
 
Ctrl + U  Underlines the selected cells 
 
Ctrl + V   Pastes copied or cut items into the selected cell 
 
Ctrl + W  Closes the active workbook 
 
Ctrl + X   Cuts the selected cells 
 
Ctrl + Y   Repeats the last repeatable action 
 
Ctrl + Z   Undoes the last action 
 
Hovering over the relevant icon in the task ribbon also displays the shortcut keys. 
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HOW TO USE FORMAT PAINTER 
 
There is an icon on the toolbar in MS Office applications that is a little gem. 
 
It saves so much time when typing / formatting spreadsheets.  It's the Format Painter icon. 
 
What does it do? 
Basically it does exactly what it says… it paints (copies) the format of a selected area and applies it to 
another (hover over the icon and it will give you a description of what it does). 
 

 
 
Where do I find it? 
You'll find this icon in the Home section of the ribbon, in the Clipboard group. 
 

 
 
Below is an example of what it can be used for in Excel. 
 
The Format Painter will work with cells as well as text, so if you have a cell that is formatted as 
shaded, bold, currency or whatever type of number formatting you have, by clicking the Format 
Painter icon and then clicking the cell you want to change, it will automatically re-format that cell to 
be identical. 
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For example, you want the two cells containing "normal" numbers to be formatted the same as the 
"price" cell, so click on cell B4, go to Format Painter, then highlight cells B7 and B8 together, let go of 
the mouse and it will automatically re-format to be the same. 
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If you want multiple places within the spreadsheet to be changed, double-click the Format Painter 
icon.  
 
Personally, I think Format Painter is a tool that is really under-used, which is a shame as it’s so handy 
for quick formatting. 
 
 
 
 
 
 
  

 

Ninja Note: 
To close Format Painter either 
press the Escape key or click 
on the Format Painter again. 
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HOW TO VIEW SPREADSHEETS SIDE BY SIDE 
 
When using Excel, if you’re anything like me, the chances are that you’ll have more than one 
spreadsheet open at the same time.  Whether it’s because you’re copying & pasting from one 
workbook to another, or looking up data from another spreadsheet, it’s actually quite time-
consuming (& annoying!) clicking from one workbook to another. 
 
Below is a step by step guide to viewing 2 spreadsheets side by side. 
 
Open the spreadsheets as normal, then go to View tab in the ribbon at the top of the page. 
 

 
 

The simplest way is to click on View Side by Side, which then arranges the spreadsheets side by side.  
You’ll notice that when you scroll in one of the spreadsheets, the other moves at the same time – if 
you don’t want this to happen, click Synchronous Scrolling (under the View Side by Side button), 
and they can now each be moved independently. 
 

 
 

If you don’t want them to be shown vertically side by side, then you can choose how you want to 
arrange them by clicking Arrange All.  This brings up a menu for you to choose how you want to 
arrange the windows i.e. vertically, horizontally, tiled etc. 
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If you have more than 2 spreadsheets open and want to view 2 of them side by side, it will ask you 
which other spreadsheet you want to compare it with, when you click on the View Side by Side 
button.  Select which other spreadsheet you want to look at. 
 

 
 

That’s it!  I hope you found it useful – it’s one of those tools that come in handy.  It’s easy to set up 
and use and I find it invaluable with spreadsheet work. 
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HOW TO VIEW A CALCULATOR 
 
Whenever I want to know the answer to a calculation I usually type in a formula (I usually always 
have a spreadsheet open somewhere on my laptop!), but sometimes only a calculator will do. 
 
So, what do you do if you haven't got one nearby? Of course there's the option of going to the start 
button, typing in calculator and opening one through Windows.  But, did you know the same feature 
is also available in Excel? Once it's added to your toolbar, you can access it with one click of the 
mouse. 
 
It’s actually hidden by default, so in order to access it you’ll need to add it to your toolbar.  
 
Click on the drop down arrow to the right of the Quick Access Toolbar and select More Commands. 
 

 
 

Then under Choose commands from: click All Commands, then scroll down to Calculator, click Add 
and OK. 
 



 

EXCEL TUTORIALS How To View A Calculator Page | 20  
 

 

MS Excel 2007 Tutorials | OutofhoursAdmin 

 
 

The icon will now appear on the Quick Access Toolbar… 
 

 
 

Click on the icon to view the calculator – you can even view a scientific, statistics or programmer 
type of calculator! 
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Now you have a calculator at your fingertips. 
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HOW TO MOVE QUICKLY BETWEEN SHEET TABS 
 
Below is a shortcut to move to different sheet tabs within the workbook, which you may not already 
know. 
 
To move to the next sheet on the right press Ctrl+PageDown… 
 
 

 
 
 
To move to the next sheet on the left press Ctrl+PageUp… 
 
 

 
 
 
Short and sweet but it saves all that mouse clicking! 
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HOW TO RENAME SHEET TABS 
 
When you first open an Excel spreadsheet, you’ll see that the sheet tabs are automatically named 
Sheet1, Sheet2, Sheet3 etc along the bottom of the screen… 
 

 
 
You can change the name of these sheets so they’re relevant to the information contained within 
each spreadsheet. For example, you could have a sheet called “Sales” which contains all of your sales 
invoicing data, another one could be called “Purchases” which obviously contains all of your 
expenses, and so on. 
 
To rename the individual sheets, all you have to do is right click on the name to bring up a menu, 
and select Rename.  You can also use this menu for deleting the sheet, changing the tab colour, 
hiding the sheet etc… 
 

 
 
This will highlight the “Sheet1” ready for you to overtype with your required name, press return 
once you’ve finished. Then repeat with the rest of the sheets… 
 

 
 
Another (quicker) way of renaming sheets is to double-click the sheet name, so the name becomes 
highlighted, type in the required name and press return. 
 
If you find you’ve run out of worksheets and want to add more to the file, click on the last sheet tab 
which has the new sheet icon on it… 
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Ninja Note: 
To quickly insert a new sheet 
press Shift+F11 
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HOW TO CHANGE THE SHEET TAB COLOUR 
 
When you're working with many spreadsheets within one workbook, you might find it easier to 
apply different colours to the sheet tabs.  For example I have a workbook containing all my contacts 
from various networking events – each group is in a separate sheet and, purely for aesthetic reasons, 
I've decided to make them look colourful. 
 
You'll see below my different sheet tabs all looking boring & grey… 
 

 
 
To change colour, all we have to do is right click on the tab name, select Tab Colour and choose 
which colour we like… 
 

 
 
You'll notice that it doesn't actually look like it's coloured the tab very well – this is because when 
the sheet is active the text appears underlined in that colour. 
 

 
 
As soon as we move onto a different sheet, the tab will become a block colour… 
 

 
 
Then repeat the process for the other tabs… 
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To remove the colours, all you have to do is right click on the sheet tab name, select Tab Colour and 
choose No Colour, and the tab will change back to the default colour. 
 

 
 
Of course, colour coding tabs is also useful if, for example, you're checking through worksheets – you 
can colour ones that you've checked in green and ones that you haven't in red etc. It's not just to 
make them look pretty! 
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HOW TO DISPLAY COMMENTS 
 
Comments are a very useful feature in Excel especially if the spreadsheet is being viewed by a 
number of people. They are a way of informing people of specific formulas or tasks.  For example if 
you have a cell which contains a certain date, you can add a comment explaining what this date is, or 
how you arrive at this date etc. 
 
But first, how do you know if a comment is actually in a worksheet to begin with?  If you see a red 
triangle in the top right corner of a cell, this means there is a comment attached to that particular 
cell. So in the example below, cell B4 contains a comment… 
 

 
 
If you hover over that cell, a comment/text box will appear telling you the name of the author of the 
comment and the actual text itself… 
 

 
 
By default the actual comment text box is hidden, if you want to keep the comments displayed on 
the screen there are a couple of ways to do this… 
 

 Method 1: Right click on the cell that contains the comment and choose Show/Hide 
Comments… 
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 Method 2: Go to the Review tab on the ribbon and choose either Show/Hide Comment 
(for that particular cell) or Show All Comments… 

 

 
 
 
To hide the comment, repeat either of the above methods. 
 
 
 
 
 
 
 
 
 
 
 
  

 

Ninja Note: 
To quickly insert or edit a 
comment press Shift+F2 
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HOW TO PRINT COMMENTS 
 
This tutorial is for when you have a printed hard copy of a spreadsheet which contains comments.  
How can you see the comments? There are 2 ways of printing the comments; you can either print 
them as they appear in the worksheets, or you can print them at the end of the page. 
 

 To print them as they appear in the sheet. 
 
Firstly click on Page Layout in the ribbon, go to the Sheet Options group (4th section along) and click 
on the dialog box launcher (in the bottom right corner)… 
 

 
 

Click on the drop down arrow next to Comments, select “As displayed on sheet”, and click OK… 
 

 
 

Then view in print preview or go straight to print. 
 

 To print them at the end of the sheet. 
 
Follow the above steps, but choose At end of sheet when clicking on the drop down arrow… 
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This will insert the comment on the last page of the printed documents and will reference the cell 
that the comment is in… 
 

 
 

Again, print as normal. 
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HOW TO SHOW FORMULAS 
 
I often receive spreadsheets from my clients that either they or someone else has started off, it can 
be a little confusing trying to suss out where the information has come from e.g. is it a formula or a 
link from another worksheet etc. 
 
Rather than go into every cell individually to see if a formula appears in the formula bar, an easier 
way is to show all formulas. 
 
Go to the Formulas tab in the ribbon, and click on Show Formulas in the Formula Auditing section. 
 

 
 

The example below shows what looks like text and numbers, if you show formulas, you'll see 2 of the 
columns actually contain formulas… 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
  

 

Ninja Note: 
You can also use the 
keyboard shortcut Ctrl+` 
to show formulas. 
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HOW TO CONVERT MEASUREMENTS 
 
This is a handy formula that I think everyone should know! How many times have you seen 
something measured in miles & you want to know the kms (or vice versa)? One way is to quickly go 
on to the internet & “google” the answer, however if you don’t have access to the internet at that 
time then you can do the conversion quickly & easily in Excel… 
 
This example shows the approximate distance from Portlaoise to Dublin city centre in miles. To 
convert the distance into kms, we use the “convert” formula… 
 
=convert(number, “from” , “to”) eg from miles to kms / from g to kg etc. 
 

 
 

You’ll see in the above image I’ve typed =convert(B6, cell B6 is where the number I want to convert 
is located, a list of measurements then appears & we select (double click) on the one we want – in 
this example miles. 
 
Next we type a comma, and the same list of measurements appears for us to choose which one we 
want to convert it to. You’ll notice that kilometre is not listed so we manually type “km” as per the 
image below… 
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TIP: A couple of things to remember – the list of measurements is not complete.  In addition to the 
basic units, there are also multiplier options which apply mostly to the metric measurements. For 
example ‘m’ is the abbreviation for metre and ‘k’ is the multiplier prefix for ‘kilo’ or x 1000 – put the 
two together to get ‘km’ the CONVERT abbreviation for kilometre.  Also the formula will only work if 
there are quotation marks around the “from” and “to” units. 
 
And that’s it! A simple way to convert measurements using Excel. For a longer list of measurements 
which can be used click here. 
 
 
  

https://support.office.com/en-us/article/CONVERT-function-D785BEF1-808E-4AAC-BDCD-666C810F9AF2
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HOW TO USE LEFT, RIGHT AND MID FUNCTIONS 
 
I was with a client the other day and noticed they had downloaded information from their 
accounting software into Excel.  They were retyping data that was already there because they 
wanted the information in separate columns.  I showed them a quick and easy way of doing this by 
using formulas… 
 
Let’s say we have a list of invoices downloaded into Excel, each cell contains the invoice number (4 
digits), the customer code (also 4 digits) and the due date (5 characters including the “-“)… 
 

 
 

In order to have these 3 elements in separate columns, we need to use the Left, Mid and Right 
functions. 
 
Firstly click on the cell where you want the first section of data to appear.  In this example we want 
column C to contain the invoice numbers, column D to have the customer codes and column E to 
contain the due dates. 
 
So, in cell C2 we need to type in the following formula:- 
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This formula is then copied down to the end of the list, so column C contains the invoice numbers… 
 

 
 

Next we want to do the same for the customer code, but this isn’t at the start of the text, this is in 
the middle of the text – for this we use the Mid formula.  Click on cell D2 and type the following… 
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This formula is then copied down to the end of the list, so column D contains the customer codes… 
 

 
 

Next we want to do the same for the due date, again this isn’t at the start or middle of the text, this 
is at the end of the text, and for this we use the Right formula.  Click on cell E2 and type the 
following… 
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Again, the formula is then copied down to the end of the list, so column E contains the due dates… 
 

 
 

And that’s it – 3 quick and easy formulas to help you save a bit of time. 
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HOW TO CHANGE ‘+’ NUMBERS TO ‘-‘ NUMBERS 
 
You know when you have a really long list of numbers that has taken you a fair amount of time to 
input, and then you suddenly realise they should all be negative numbers, and your stomach sinks?! 
Well, this is a quick guide on how to change them in one go, without having to retype them. 
 
Below is a list of random unformatted positive numbers. 
 

 
 
In order to change them all to negative numbers, type -1 in a blank cell…. 
 

 
 
Select that cell, go to the Home tab on the ribbon and click copy (or press ctrl+c)… 
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Highlight the list of numbers, and click Paste Special… 
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Choose Multiply from the dialog box that appears and click OK… 
 

 

Ninja Note: 
Press Ctrl+Alt+v after copying to 
also open the paste special 
dialog box. 
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And all of the numbers within the highlighted area change to negative numbers. 
 

 
 
You can then delete the cell containing -1 if you wish. 
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HOW TO CHANGE TEXT CASE 
 
Have you ever re-typed a list in Excel because it was in the wrong text case? 
Next time, use formulas to change the text case… it saves so much time! 
 
If, for example, Column A contained text which was a mixture of upper and lowercase letters – it 
might look a bit messy, it may only be your shopping list, but it still doesn’t look right! 
 

 
 
So you want to tidy it up a bit and have all words begin with a capital letter.  Go into the next blank 
cell and use the formula “proper” to change it:- 
 

 
 
Then use the autofill handle (bottom right corner of the cell) and drag the formula down to the end 
of your list (or copy & paste the formula down, whichever you prefer).  This then duplicates your list 
in proper text i.e. capital letter at the start of every word. 
 

 

Ninja Note: 
Double click the autofill handle 
& the formula will automatically 
copy down to the last row of the 
list. 
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Of course, now when you delete the text in column A, everything in column B disappears! This is 
because it still contains a formula linking to the text in column A.  To rectify this, you need to paste 
special the cells. 
 
Highlight the text in column B (all cells which contain a formula), click Copy (or press Ctrl+C), then 
right click the mouse and select Paste Special… 
 

 
 

 
 
 
 
 
 
 
 
 

 

Ninja Note: 
Press Ctrl+Alt+v after copying to 
also open the paste special 
dialog box. 
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This will open another menu where you can choose how you want to paste the cells.  You want to 
get rid of the formulas and just keep the actual value/text of the cell, so click on Values and press 
OK. 
 

 
 
You’ll then notice that column B, which had the formula in, now contains the correct text – and you 
can now delete everything in column A 
 

 
 
The same method applies if you want the text all in capitals, or all in lower case – the only change is 
the formula. 
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For CAPITALS, use:- 
 

 
 
Then copy and paste special values as before. 
 

 
 
For lowercase, use:- 
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Again copy & paste special values as before. 
 

 
 
And that’s it! Hopefully it will save you time, instead of having to type things out again! 
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HOW TO INSERT BULLET POINTS INTO A SPREADSHEET 
 
This is one of those little nuggets that you might not realise you need to know, but will end up using 
it all the time now that you know! 
 
Excel doesn’t have a button for inserting bullet points like in Word, however there are a couple of 
ways to add them… 
 

 Method 1 
 
Make sure your cursor is in the cell where you want the bullet point to appear, then go to the Insert 
tab on the ribbon and click Symbol over on the right hand side… 
 

 
 

This opens the Symbols dialog box, click on Font and choose the font you’d like to use… Wingdings 
and Webdings are generally good ones for different types of bullet points… 
 

 
 

Choose the symbol you want to use, click Insert and Close and the symbol will appear. 
 

 Method 2 
 
If you want to use the standard filled in circle and hollow circle as bullet points then a much quicker 
way is to type the following: 
 

 Alt+7 gives you the small black circle. To change the colour you can go to the Home tab and 
select the font colour you’d like to use. 
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o Alt+9 gives you the hollow circle. Again you can change the colour as above. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 

Ninja Note: 
You must use the numeric 
keypad for the above keyboard 
shortcuts to work. 
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HOW TO HIDE / UNHIDE A WORKSHEET 
 
When working in a spreadsheet there may be a time when you don’t necessarily want to see all of 
the sheets. For example, one of the sheets may contain the lists that are being used for the drop 
down data, which you don’t need to see.  Hiding the sheet will have no effect on any formulas or 
references and data contained in that sheet can still be used in other worksheets. 
 
In my example I have 3 sheets called Sales, Purchases and Lists. I want to hide the Lists worksheet. 
 

 Method 1 – the ribbon way 
 
Make sure you’re in the worksheet you want to hide (if you’re not then click on the tab of the 
worksheet you want to hide)… 
 

 
 

Click on the Home tab in the ribbon, and go to the Cells section… 
 

 
 

Click on the Format drop down arrow, and choose Hide & Unhide in the Visibility section… 
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Then select Hide Sheet to hide the current worksheet… 
 

 
 

The worksheet will now be hidden… 
 

 
 
If you want to hide more than 1 worksheet, click on the first worksheet you want to hide, then hold 
down Ctrl and click on the tabs of the other worksheets you want to hide and follow the above 
steps. 
 
To unhide any hidden worksheets go to Cells section on the Home tab of the ribbon, click on Format, 
choose Hide & Unhide and select Unhide Sheet… 
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This will open up a dialog box listing all worksheets that are currently hidden, select the sheet that 
you want to unhide and click OK… 
 

 
 
The worksheet has now reappeared. 
 

 Method 2 – the mouse way 
 
As above, make sure you’re currently in the worksheet that you want to hide, then right click on the 
sheet name – in this example it’s Lists, and select Hide… 
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And that’s it, Lists becomes hidden!  To unhide, again right click the mouse on any sheet name, and 
choose Unhide.  A dialog box listing all worksheets that are currently hidden will open, select the 
sheet that you want to unhide and click OK. 
 
  

 

Ninja Note: 
You could also use the following 
keyboard shortcut to hide 
sheets: Alt+o+h+h 
To unhide use: Alt+h+o+u+h 
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HOW TO HIDE COLUMNS AND ROWS 
 
If you have a lot of data in a spreadsheet and you only want to focus on a certain area, it's 
sometimes useful to hide the columns and/or rows that you don't want to see.  There are 3 different 
ways of doing this, all of them quick and easy. 
 
To hide columns… 
 

 1) The Ribbon Way 
 
Click on a cell in the column that you want to hide. Make sure you're on the Home tab in the Ribbon 
– go to the Cells section – click on Format and choose Hide & Unhide – Hide Column. 
 

 
 

 2) The Mouse Way 
 
Select the whole column by clicking on the column header (A, B, C etc) of the column you want to 
hide – right click – select Hide. 
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 3) The Keyboard Way 
 
Select a cell in the column you want to hide – press Ctrl+0. 
 

 
 
To hide rows… 
 

 1) The Ribbon Way 
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As before, click on a cell in the row that you want to hide. Make sure you're on the Home tab in the 
Ribbon – go to the Cells section – click on Format and choose Hide & Unhide – Hide Row. 
 

 
 

 2) The Mouse Way 
 
Select the whole row by clicking on the row header (1, 2, 3 etc) of the row you want to hide – right 
click – select Hide. 
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 3) The Keyboard Way 
 
Select a cell in the row you want to hide – press Ctrl+9. 
 

 
 
The same methods go for unhiding columns/rows: 
 
To unhide a column – select a range of cells to the left and right of the hidden column, choose any 
of the methods above but select unhide instead of hide.  With the keyboard shortcut press 
Ctrl+Shift+0 to unhide. 
 
To unhide a row – select a range of cells above and below the hidden row, and again select unhide 
when using the above methods, or Ctrl+Shift+9 if using the keyboard shortcut. 
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HOW TO REPEAT ROWS AND COLUMNS WHEN PRINTING 
 
This short guide is to show you how to repeat certain row headers or columns when printing.  For 
those of us who spend ages getting a table “just right” on screen, then it goes pear shaped when you 
print it off. 
 
Below is an example of a table that I want to print off – on screen it’s fine as I’ve frozen panes so the 
headers are always visible. 
 

 
 
However, when I go to Print Preview it looks a mess – even after I’ve set the page layout to how I 
want it… 
 

 
 

 
 
Pages 2 and 3 of the preview don’t really show us what they correspond to, so how do we get the 
headers to repeat? 
 
Firstly go to Page Layout in the Ribbon and select Print Titles in the Page Setup section.  If you hover 
over the Print Titles button, a description pops up to explain what it does… 
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A dialog box opens where you can choose the rows to repeat at top and/or columns to repeat at 
left… 
 

 
 
Click on the little box (technical term) on the right… 
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Then choose the row you want to repeat – in this example we want to repeat the table headers so it 
will be row 3. 
 

 
 
Click back on the “small box” and it will take you back to the dialog box, repeat the same method for 
choosing a column to repeat, for example column A, and click OK… 
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You’ll not notice any difference on the actual spreadsheet, but if you now go back to print preview, 
you should see that the table header and the 1st column are now repeated on each page – below is 
page 3 in print preview… 
 

 
 
And that’s how you repeat rows / columns when printing. 
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HOW TO FREEZE ROWS AND COLUMNS 
 
Don’t you hate it when column headings in a table in Excel disappear when you scroll down?  How 
are you supposed to remember which information goes in which column of the table?  Well, you can 
freeze the row so it’s always visible. 
 
Below is an example of a table that you might use to input all those business cards you collect from 
networking. 
 

 
 
You’ll notice as you scroll down that the whole table moves down.  This is no good if your table is 
hundreds of rows long, so how do you get the headings to always show at the top of the page? 
 
Firstly, go to View in the ribbon and click on Freeze Panes (in the Window section) 
 

 
 
This will bring up the following menu… 
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Freeze Panes – This freezes the rows above and columns to the left of the cell you’ve selected.  For 
example, if I click on cell E13 in the table and select Freeze Panes, you’ll notice a line has appeared 
between columns D and E, and between rows 12 and 13. 
 

 
 
When you scroll down, all rows above 13 are still showing… scroll right and all columns to the left of 
column E are still visible.  Below is an example showing how columns have jumped from D – H, and 
rows have jumped from 12 – 34 after scrolling. 
 

 
 
To undo the frozen panes at any time, click back on Freeze Panes (on the View tab in the ribbon), 
and you’ll see there is now an option to Unfreeze Panes.  Click this and it all returns to normal. 
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Freeze Top Row / Freeze First Column – These 2 options do exactly what they say.  Click on Freeze 
Top Row, and it freezes the very first row of the spreadsheet, no matter what cell you’re currently 
in.  Click on Freeze First Column, and again it freezes the very first column which is visible on the 
spreadsheet (usually column A, unless that column is hidden). 
 
Neither of these 2 options is any good for our table as it would still mean the column headings would 
move when we scroll down. 
 
I want to be able to see the column headings when I scroll down, and the Company Name if I scroll 
over to the right, so click on cell B6, and select Freeze Panes. 
 

 
 
Now scroll down and right to see if it’s worked… and that’s how to freeze rows / columns. 
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HOW TO INSERT AUTOFILTER 
 
When you have a list of data in Excel, one of the most useful things you can do is add the Autofilter 
option.  By adding this feature, it enables you to sort and filter the information contained within the 
table / list. 
 
Let’s take this example of an invoice list.  The first thing to do is make sure your list has column 
headers e.g. invoice number, date etc… 
 
Click anywhere within the list and you can either… 
 
a) go to Data tab on the ribbon and click Filter 
 

 
 

or b) go to the Editing section in the Home tab and click Sort & Filter – Filter. 
 

 
 

It doesn’t really make any difference which way you choose. 
 
Click on a filter arrow of one of the columns and you’ll see there are more options for your filtering… 
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And if the filter option that you want isn’t there, you can still set your own criteria by clicking on 
Custom Filter… 
 
Personally once I have a list typed out, the first thing I do is apply an autofilter, it makes the sorting 
and viewing of data so much quicker and easier. 
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HOW TO MERGE CELLS WITHOUT LOSING DATA 
 
How many times have you tried to merge 2 cells together in Excel only to have this message appear? 
 

 
 
It’s so frustrating… so, I thought I’d share with you how to do it without losing any of the data. 
 
Firstly highlight the cells that contain the data you want to merge, increase the width of the column 
so it will be wide enough for all the data to fit in. 
 
Click on the Home tab on the ribbon, go to the Editing group, click on the Fill drop down arrow and 
choose Justify… 
 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 

 
  

 

Ninja Note: 
Make sure the column is 
widened first otherwise it 
won’t work! 
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HOW TO DELETE BLANK ROWS QUICKLY 
 
There are times when your spreadsheet will have blank rows within a list of data, and going through 
line by line to manually delete them is not an option – below is a quick and easy way of deleting 
these blank rows all at once. 
 
Firstly highlight one of the columns within your list from the top to the bottom… 
 

 
 
Then, press F5 or Ctrl+g which will open the Go To dialog box, and click on Special… 
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Click on Blanks, then OK… 
 

 
 
This will highlight the blank cells within the list… 
 

 
 
Then press Ctrl+minus (-) to bring up the delete options, select Entire Row… 
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…and the blank rows will be deleted… 
 

 
 
And that’s it – a really quick and easy way of removing blank rows. 
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HOW TO CREATE A DROP-DOWN LIST 
 
This tutorial is going to show you how to create a drop-down list in Excel.  I think it's one of those 
features that everyone should know how to do – it saves time and is very useful. 
 
It uses a function called Data Validation, which basically means users can only input data which is 
valid, data which you have specified. 
 
Part 1 shows how to create a basic list using data contained in the same worksheet.  Part 2 shows 
the data being contained in a different worksheet to the list. 
 
Part 1 
 
In this example, we have a column with the heading Month, only months of the year can be input 
into this column so we need to set up a drop-down list specifying the months of the year, this way 
the user can only input what's included in the list. 
 

 
 
To set this up we first need to type the list, in this case the months of the year.  Then highlight the 
column or area where we want the drop-down list to appear… 
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Next, we go to the Data tab on the ribbon and select Data Validation… 
 

 
 
This will open a dialog box where we enter the criteria for the data. Select List on the drop-down 
arrow where it says Allow… 
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Another option then appears where we specify the range that contains the items (in this example it's 
the list of the months in cells E4:E15).  Make sure In-cell drop-down is ticked and click OK… 
 

 
 
You'll notice a little drop-down arrow has now appeared to the right of the first cell in the 
highlighted area. If we click on the arrow, the list of months should appear for us to select from… 
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And that's how to create a drop-down list.  This example had the list of months in the same 
worksheet as the cell that contains the drop-down. 
 
Part 2 
 
If we want our list to be in a different worksheet then we would have to provide a name for the 
range that contains the list. 
 
For example Sheet 1 is where we want the drop-down selection to be, and Sheet 2 (called Lists) is 
where the list is located. 
 

 
 
We want to name our range "Months", so highlight the list of months, select Formulas tab on the 
ribbon and click Define Name.  Type in the name and you'll notice the Refers to box already has the 
range in there (because we highlighted the months first), click OK. 
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Go back into Sheet 1 and highlight the area where we want the drop-down to appear, select the 
Data tab in the ribbon and Data Validation. Choose Allow List (the same as in Part 1), type in 
=Months in the Source box, and click OK… 
 

 
 
And the drop-down arrow will appear containing the months… 
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And that's it!  There are other options for data validation i.e. text length, date, time etc, but the 
drop-down list is, in my opinion, one of the easiest and most useful to know. 
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HOW TO CONDITIONALLY FORMAT A CELL 
 
Conditional formatting is used when you want to change the appearance of a cell depending on 
certain conditions; for example, if you have a table showing sales, you may want to pick out the 
values over a certain amount, with conditional formatting you can set the cells to automatically be a 
different colour. 
 
Below is a step by step guide on how to do it. 
 
The following spreadsheet shows monthly invoicing amounts… 
 

 
 
Let’s say we want to see all total invoiced amounts over €1200, firstly we need to highlight the 
Invoice Total column, then in the Home tab, select Conditional Formatting, this will drop down a 
menu where we can choose to highlight cell rules, top/bottom rules, data bars, colour scales, icon 
sets. 
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We need to click on Highlight Cells Rules and select Greater Than… as we want to set a condition to 
show cells with a greater value than €1200. 
 

 
 
This will open a dialog box asking us to enter the value we wish the cell to be greater than (i.e. 
€1200), we then select the colour formatting we want the cells to undertake. 
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Once we have chosen the colour and clicked okay, all of the cells over €1200 within the Invoice Total 
column will now be a different colour.  And, because the whole column was selected to begin with, it 
means any future amounts entered on this spreadsheet will automatically have the same formatting. 
 

 
 
Another thing you may have noticed is that the Invoice Total column header also changed colour.  To 
change this back again a simple way of copying a format from one cell to another is Format Painter.  
This icon is located in the Clipboard section of the Home menu. 
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To use this we first click on the cell whose format we want to copy – we’ll be copying the Hourly 
Rate header cell.  Then click the Format Painter icon and you’ll notice a flashing dotted line appear 
around the cell we selected. 
 

 
 
Then, click on the cell we want to be pasted and the format changes immediately. 
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Other format conditions we can choose are Less Than, Between, Equal To – these work in the same 
way as the Greater Than rule.  We can also choose cells which has Text that Contains, Date 
Occurring (i.e. yesterday, last month etc), or Duplicate Values. 
 

 
 
Let’s choose Text that Contains as another example.  All invoices where payment has been received 
we want the Yes to be shaded in green so, we highlight the Payment Received column, go to 
Conditional Formatting, select Highlight Cells Rules and Text that Contains… 
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Type in the text that the cell must contain in order to be formatted (i.e. Yes) and choose the colour 
that we want the cell to change to (i.e. green) 
 

 
 
All the cells within that column that contain the text Yes will now change to green.  Again, because 
the whole column was selected, it means future entries will automatically be formatted the same 
way.  You’ll notice the column header didn’t change this time, this is because it didn’t contain the 
relevant text (i.e. Yes) 
 

 
 
I hope this has been helpful to anyone who doesn’t know much about formatting cells – of course, 
there are many more formatting rules and options which I haven’t covered yet.  This was a basic 
example to get you started! 
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HOW TO IDENTIFY DUPLICATE DATA USING CONDITIONAL FORMATTING 
 
Whenever we have a large list of values (whether it’s numbers or text), there is always a risk of 
duplication.  This tutorial shows you how to use conditional formatting to identify any duplicated 
data by highlighting it… 
 
The example below shows a random list of numbers.  The first thing to do is highlight the section you 
want to check, and click on Conditional Formatting which is in the Styles section in the Home tab of 
the ribbon… 
 

 
 
Next click on Highlights Cells Rules, and choose Duplicate Values… 
 

 
 
A dialog box will open where you can then choose how your cells will be highlighted… 
 



 

EXCEL TUTORIALS How To Identify Duplicate Data Using Conditional Formatting Page | 83  
 

 

MS Excel 2007 Tutorials | OutofhoursAdmin 

 
 
Click OK, and you’ll see that all cells containing duplicate values are now highlighted… 
 

 
 
And that’s it! A quick and easy way to identify duplicate values.  The formatting will remain in the 
cells you have chosen, so as soon as you change any of the duplicated values the formatting will 
automatically update. 
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HOW TO REMOVE DUPLICATE VALUES 
 
Imagine you have a long table containing contact details. How do you know that the data you have 
in there isn't duplicated? 
 
There is an easy way of checking and removing any duplicate data without having to manually go 
through the list yourself. 
 
Firstly click anywhere within the table, then make sure you're in the Data tab. 
 

 
 
There are a couple of ways to deal with duplicated data, it all depends whether you want to hide it 
or remove it.  Also, you must remember that, in order for Excel to recognise it as duplicate data, the 
information has to be identical – for example J. Bloggs and J Bloggs would not be classed the same as 
the full stop is missing.  It has to be the same! 
 

 HIDE 
 
To hide any duplicates, go to the Sort & Filter section of the Data tab, and click Advanced. 
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A new dialog box will open, and your table will automatically be highlighted as the List range.  Tick 
the Unique records only box, and leave the "Filter the list, in-place" ticked, and press OK. 
 

 
 
This basically instructs Excel to show the unique data only in the same place as the existing table i.e. 
get rid of any duplicated entries.  You'll notice that J. Bloggs in row 13 is now hidden and the table is 
only showing unique information. 
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 REMOVE 
 
To completely remove the data, Excel 2007 has a feature called (surprisingly) Remove Duplicates. 
 
Again, this is in the data tab of the ribbon, make sure you've selected any cell within the table and 
click Remove Duplicates. 
 

 
 
This opens a new dialog box where you can select which columns you want included in the search 
for duplicates.  In this example, we'll leave all selected, and click OK. 
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Immediately, if there any duplicates, another alert will come up saying how many duplicate values 
were found and removed. 
 

 
 
And you'll notice that J. Bloggs in row 13 has been completely removed. 
 

 
 
One more thing to bear in mind when removing duplicates is that Excel removes the displayed 
information, and not what is necessarily shown in the formula bar.  For example, the date may be 
displayed as 10/10/2011 in one cell and 10-Oct-11 in another, although it’s the same date, they are 
displayed differently therefore Excel won't recognise them as being duplicates. 
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HOW TO REPEAT A COMMAND 
 
The majority of us know about the repeat command in Excel, where you press Ctrl+Y and it will 
repeat the last single action we did… 
 
For example, the table below has cell A6 filled in red.   
 

 
 
This was the last action that was done, so if we click on a different cell (C11 for example), and press 
Ctrl+Y, that cell will also fill in red. 
 

 
 
But, what happens if we carry out lots of formatting in a particular cell and want to repeat the 
formatting for other cells? 
 
Pressing Ctrl+Y will only repeat the last single action carried out, so if we bold a cell, make the text 
blue and underline it, the last single action would be the underline. 
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In order to repeat all the formatting as a single action, we need to go into format cells.  If we right 
click on the cell where we want to apply the formatting, and select Format Cells… 
 

 
 
We can then carry out the formatting in one go… 
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Click OK, and the cell changes.  If we then go to a different cell and press Ctrl+Y, all the formatting is 
repeated. 
 

 
 
So, there we have it, all changes made in the Format Cells feature are counted as one repeatable 
action. 
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THANK YOU 

  
Thanks for downloading this free ebook – I hope you have found it useful and have learnt at least 
one little nugget of information! 
 
Unfortunately I won’t be adding any more tutorials for MS Excel 2007, however please keep 
checking back on my blog for any other tutorials that might come in handy. 
 
If you find you need any help with MS Office, feel free to contact me via OutofhoursAdmin. 
 
Thanks again, 
 
 
 
 
 
 

Sharon 

 

http://www.outofhoursadmin.ie/category/blog/
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